SEM supportsCMM-SW Level 2

Mapping of the DOE Systems Engineering Methodol ogy to the Software Engineering Institute (SEI) Software Capability Maturity Model (CMM-

SW) level 2.
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REQUIREMENTS MANAGEMENT
RM-1 The software engineering group reviewsthe | Chapter 3.0 * Project Plan * Reguirements
allocated requirements before they are « Develop High-Level Project » Requirements Management
incorporated in the software project. Requirements Specification awareness
Chapter 4.0 Document » Defining Project
» Establish Functional Baseline Requirements
RM-2 The software engineering group uses the Chapter 3.0 * Project Plan * Reguirements
allocated requirements as the basis for » Develop High-Level Project * Requirements Management
software plans, work products, and Requirements Traceability Matrix awareness
activities Chapter 4.0 « Revised Project » Defining Project
» Develop Requirements Plan Requirements
Traceability Matrix
» Establish Functional Baseline
* Revise Project Plan
RM-3 Changes to the allocated requirementsare | Chapter 4.0 * Revised * Regquirements
reviewed and incorporated into the software | «  Requirements Management Requirements Management
project. »  Establish Functional Baseline Specification awareness
Document » Defining Project
Requirements
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SOFTWARE PROJECT PLANNING
SPP-1 The software engineering group participates | Chapter 3.0 * Project Plan * Project Planning
on the project proposal team. » Define Project Objectives * Project Profile Checklist
» Define Project Scope » Feasibility Review
» Establish Communication or Feasibility
with Functional Areas Study
SPP-2 Software project planning isinitiated in the | Chapter 2.0 * Project Plan * Microsoft Project
early stages of, and in paralel with, the » Lifecycle Mode  Project Profile SEM Models
overall project planning. Chapter 3.0 *  Work Breakdown * Project Plan
« Define Project Objects Structure (WBS) Example
» Define Project Scope
» Develop Project Plan
SPP-3 The software engineering group participates | Chapter 3.0 * Project Plan * Project Planning
with other affected groupsin the overall « Establish Communication + Project Profile Checklist
project planning through the project’ slife. with Functional Areas « Quadlity Assurance | * Project Plan
* Develop Project Plan Plan Example
SPP-4 Software project commitments made to Chapter 2.0 * Project Plan * Project Planning
individuals and groups externa to the e Lifecycle Mode « WBS Checklist
organization are reviewed with senior Chapter 3.0 e Quality Assurance | ¢ Project Plan
management according to a documented « Develop Project Plan Plan Example
procedure.
SPP-5 A software lifecycle with predefined stages | Chapter 2.0 * Project Plan * Project Planning
of manageable sizeisidentified or defined. | « Lifecycle Model Checklist
Chapter 3.0 * Project Plan
» Develop Project Plan Example
* Microsoft Project
SEM Models
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SOFTWARE PROJECT PLANNING
SPP-6 The project’ s software development planis | Chapter 2.0 * Project Plan * Project Planning
developed according to a documented » Lifecycle Model e WBS Checklist
procedure. * Project Sizes * Project Plan
e Adapting the Lifecycle Example
Chapter 3.0 * Microsoft Project
» Develop Project Plan SEM Models
SPP-7 The plan for the software project is Chapter 3.0 * Project Plan * Project Planning
documented. » Develop Project Plan « WBS Checklist
* Project Plan
Example
* Microsoft Project
SEM Models
SPP-8 Software work products that are needed to | Chapter 3.0 * Project Plan * Project Planning
establish and maintain control of the  Develop Plan « Configuration Checklist
software project are identified. «  Develop Configuration Management Plan | » Project Plan
Management Plan Example
* Microsoft Project
SEM Models
SPP-9 Estimates for the size of the software work | Chapter 2.0 * Project Plan * Project Planning
products (or changes to the size of the * Project Sizes Checklist
software work products) are derived  Adapting the Lifecycle * Project Plan
according to a documented procedure. Chapter 3.0 Example

* Develop Project Plan

» Develop the Project Estimate
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SOFTWARE PROJECT PLANNING
SPP-10 Estimates for the software project’s efforts | Chapter 3.0 » Feasibility Review | ¢ Project Planning
and costs are derived according to a » Determine Project Feasibility or Study Checklist
documented procedure. « Conduct Feasibility Review « Analysisof « ABC Guideline
» Conduct Feasibility Study Benefitsand Costs | « Feasibility Study
e Conduct Analysis of Benefits e Template
and Costs * Microsoft Project
» Develop the Project Estimate SEM Models
SPP-11 Estimates for the software project’s critical | Chapter 3.0 * Project Plan * Project Planning
computer resources are derived according » Develop High-Level Project * Feasibility Review Checklist
to a documented procedure. Requirements « Requirements + Project Plan
« Determine Project Feasibility Specification Example
* Investigate Software Document * Feasbility Study
Alternatives » Defining Project
* Investigate Hardware Requirements
Alternatives
* Formulate Platform Options
e Conduct Feasihility Review
Chapter 4.0
» Define Project Requirements
SPP-12 The project’ s software scheduleisderived | Chapter 3.0 * Project Plan * Project Planning
according to a documented procedure. » Develop Project Plan « WBS Checklist
* Develop Software Project * Project Plan
Schedule Example
* Microsoft Project
SEM Models
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SOFTWARE PROJECT PLANNING
SPP-13 The software risks associated with the cost, | Chapter 3.0 » Feasibility Review | ¢ Project Planning
resource, schedule, and technical aspectsof | « Conduct aFeasibility Review | « Project Plan Checklist
the project are identified, assessed, and « Develop Project Plan « Risk Management | * Risk Management
documented. + Risk Management Plan Guideines
« Contingency Plan * Risk Assessment
Questionnaire
* Feasbility Study
Template
SPP-14 Plans for the project’ s software engineering | Chapter 3.0 * Feasibility Review | ¢ Project Planning
facilities and support tools are prepared.  Conduct aFeasibility Review | « Project Plan Checklist
* Develop Project Plan * Implementation « Project Plan
Chapter 4.0 Plan Example
» Define Implementation * Feasbility Study
Requirements Template
SPP-15 Software planning data are recorded. Chapter 3.0 * Project Plan * Project Planning
» Develop Project Plan Checklist
» Develop the Project Estimate * Project Plan
Example

Date: September 2002 Page 5




SEM supportsCMM-SW Level 2

Mapping of the DOE Systems Engineering Methodol ogy to the Software Engineering Institute (SEI) Software Capability Maturity Model (CMM-

SW) level 2.

KPA KPA Activity SEM Section SME Work Product SQSE Web Site
Activity http://cio.doe.gov/sqse
Number

SOFTWARE PROJECT TRACKING AND OVERSIGHT

SPTO-1 | A documented software development plan | Chapter 3.0 * Project Plan * Project Plan
is used for tracking the software activities » Project Tracking and Example
and communicating status. Oversight * Project Tracking

» Develop Project Plan Checklist

SPTO-2 | The project’s software development planis | Chapter 3.0 e Revised Project * Project Plan
revised according to a documented * Project Tracking and Plan Example
procedure. Oversight * Project Tracking

Chapter 4.0-9.0 Checklist
* Revise Project Plan

SPTO-3 | Software project commitments and changes | Chapter 3.0 * Project Plan * Project Plan
to commitments made to individuals and » Project Tracking and Example
groups external to the organization are Oversight * Project Tracking
reviewed with senior management « Develop Project Plan Checklist
according to a documented procedure.

SPTO-4 | Approved changes to commitments that Chapter 3.0 e Project Plan * Project Plan
affect the software project are » Project Tracking and » Stage Exit Meeting Example
communicated to the members of the Oversight * Project Tracking
software engineering group and other Chapter 4.0-9.0 Checklist
software-related groups. * Revise Project Plan « Stage Exit Process

» Conduct Stage Exit Guide
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SOFTWARE PROJECT TRACKING AND OVERSIGHT
SPTO-5 | The sizes of the software work products (or | Chapter 3.0 ¢ Requirements » Configuration
sizes of the changes to the software work * Project Tracking and Specification Management
products) are tracked, and corrective actions Oversight Document Requirements
are taken as necessary. Chapter 4.0 » Configuration * Project Tracking
» Establish Functional Baseline Management Plan Checklist
Chapter 6.0
* Develop System Design
Chapter 7.0
» Establish Development
Baselines
SPTO-6 | The project’s software effort and costsare | Chapter 3.0 * Project Plan * Project Plan
tracked, and corrective actionsaretakenas | « Project Tracking and * Revised Project Example
necessary. Oversight Plan * Project Tracking
» Develop Project Plan Checklist
Chapter 4.0-9.0
* Revise Project Plan
SPTO-7 | The project’scritical computer resources Chapter 3.0 » Configuration » Configuration
are tracked and corrective actionsaretaken | « Project Tracking and Management Plan Management
as necessary. Oversight Requirements
» Develop Configuration * Project Tracking
Management Plan Checklist
SPTO-8 | The project’s software schedule istracked, | Chapter 3.0 e Project Plan » Project Tracking
and corrective actions are taken as * Project Tracking and « WBS Checklist
necessary. Oversight * Project Plan
» Develop Project Plan Example
* Microsoft Project
SEM Models
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SOFTWARE PROJECT TRACKING AND OVERSIGHT
SPTO-9 | Software engineering technical activities Chapter 3.0 e Project Plan * Project Tracking
are tracked, and corrective actions aretaken | «  Project Tracking and Checklist
as necessary. Oversight * Project Plan
» Develop Project Plan Example
SPTO-10 | The software risks associated with cost, Chapter 3.0 » Feasibility Review |  Project Tracking
resource, schedule, and technical aspectsof | « Project Tracking and or Study Checklist
the project are tracked. Oversight e Project Plan * Project Plan
» Determine Project Feasibility Example
* Develop Project Plan * Feasbility Study
Template
SPTO-11 | Actual measurement data and replanning Chapter 3.0 * Project Plan * Project Tracking
data for the software project are recorded. *  Performance Measures  Project File Checklist
» Project Tracking and * Project Plan
Oversight Example
» Develop Project Plan

Date: September 2002

Page 8




SEM supportsCMM-SW Level 2
Mapping of the DOE Systems Engineering Methodol ogy to the Software Engineering Institute (SEI) Software Capability Maturity Model (CMM-
SW) level 2.

KPA KPA Activity SEM Section SME Work Product SQSE Web Site
Activity http://cio.doe.gov/sqse
Number

SOFTWARE PROJECT TRACKING AND OVERSIGHT
SPTO-12 | The software engineering group conducts Chapter 2.0 * Project Plan * Project Tracking
periodic internal reviewsto track technical | « Quality Reviews * InStage Checklist
progress, plans, performance, and issues Chapter 3.0 Assessment * Project Plan
against the software devel opment plan. e Performance Measures « Stage Exit Example
» Software Project Tracking and Meetings » Stage Exit Process
Oversight « Structure Guide
Walkthroughs * InStage
Assessment
Process Guide
e Structure
Walkthroughs
Process Guide
» Software Quality
Assurance
SPTO-13 | Formal reviewsto address the Chapter 2.0 * Project Plan * Project Tracking
accomplishments and results of the software | «  Quadlity Reviews + Stage Exit Checklist
project are conducted at selected project Chapter 3.0 Mestings » Project Plan
milestones according to a documented Project Tracking and Example
procedure. Oversight  Stage Exit Process
Guide
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SOFTWARE SUBCONTRACTOR MANAGEMENT

SM-1 The work to be subcontracted is defined and | Chapter 3.0 * Project File * Project
planned according to a documented * Project Management Management Guide
procedure. «  Subcontractor Management

SM-2 The software subcontractor is selected Chapter 3.0 * Project File * Project
based on an evaluation of the subcontract * Project Management Management Guide
bidder’ s ability to perform the work, «  Subcontractor Management
according to a documented procedure.

SM-3 The contractual agreement between the Chapter 3.0 * Project File * Project
prime contractors and the software * Project Management Management Guide
subcontractor is used at the basis for «  Subcontractor Management
managing the subcontract.

SM-4 A documented subcontractor’ s software Chapter 3.0 * Project File * Project
development plan is reviewed and approved | « Project Management Management Guide
by the prime contractor. «  Subcontractor Management

SM-5 A documented and approved Chapter 3.0 » Project File * Project
subcontractor’s software development plan | «  Project Management Management Guide
is used for tracking the software activities *  Subcontractor Management
and communicating status.

SM-6 Changes to the subcontractor’ s statement of | Chapter 3.0 » Project File * Project
work, subcontract terms and conditions, and | «  Project Management Management Guide
other commitments are resolved according | «  Subcontractor Management
to a documented procedure.

SM-7 The prime contractor’ s management Chapter 3.0 » Project File * Project

conducts periodic status/coordination
reviews with the software subcontractor’s
management.

* Project Management
»  Subcontractor Management

Management Guide
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SOFTWARE SUBCONTRACTOR MANAGEMENT

SM-8 Periodic technical reviews and interchanges | Chapter 3.0 * Project File * Project
are held with the software subcontractor. * Project Management Management Guide

»  Subcontractor Management

SM-9 Formal reviews to address the Chapter 3.0 » Project File * Project
subcontractor’ s software engineering * Project Management Management Guide
accomplishments and results are conducted | «  Subcontractor Management
at selected milestones according to a
documented procedure.

SM-10 The prime contractor’ s software quality Chapter 3.0 » Project File * Project
assurance group monitors the * Project Management Management Guide
subcontractor’ s software quality assurance +  Subcontractor Management
activities according to a documented
procedure.

SM-11 The prime contractor’ s software Chapter 3.0 * Project File * Project
configuration management group monitors | «  Project Management Management Guide
the subcontractor’ s activities for software «  Subcontractor Management
configuration management according to a
documented procedure.

SM-12 The prime contractor conducts acceptance | Chapter 3.0 » Project File * Project
testing as part of the delivery of the * Project Management Management Guide
subcontractor’s software products according | «  Subcontractor Management
to a documented procedure.

SM-13 The software subcontractor’s performance | Chapter 3.0 * Project File * Project

is evaluated on a periodic basis, and the
evauation is reviewed with the
subcontractor.

* Project Management
»  Subcontractor Management

Management Guide
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SOFTWARE QUALITY ASSURANCE

SQA-1 A SQA plan is prepared for the software Chapter 3.0 * Quality Assurance | ¢ Quality Assurance

project according to a documented » Develop Quality Assurance Plan Template

procedure. Plan *  Quality Assurance
Plan Example

e Quality Assurance
Checklist

SQA-2 The SQA groups' activitiesare performed | Chapter 3.0 * Quality Assurance | ¢ Quality Assurance

in accordance with the SQA plan. » Develop Quality Assurance Plan Template

Plan e Quality Assurance
Plan Example

*  Quality Assurance
Checklist
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SOFTWARE QUALITY ASSURANCE
SQA-3 The SQA group participatesin the Chapter 2.0 e Quality Assurance | ¢ Quality Assurance
preparation and review of the project’s *  Quality Reviews Plan Template
software development plan, standards and Chapter 3.0 e In-Stage * Quality Assurance
procedures. » Develop Quality Assurance Assessments Plan Example
Plan » Stage Exit *  Quality Assurance
Meetings Checklist
e Structure » Stage Exit Process
Walkthroughs Guide
* InStage
Assessment
Process Guide
e Structure
Walkthroughs
Process Guide
» Software Quality
Assurance
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SOFTWARE QUALITY ASSURANCE
SQA-4 The SQA group reviews the software Chapter 2.0 e Quality Assurance | ¢ Quality Assurance
engineering activities to verify compliance. | « Quality Reviews Plan Template
Chapter 3.0 * In-Stage * Quality Assurance
* Develop Quality Assurance Assessments Plan Example
Plan » Stage Exit *  Quality Assurance
Meetings Checklist
e Structure » Stage Exit Process
Walkthroughs Guide
* InStage
Assessment
Process Guide
e Structure
Walkthroughs
Process Guide
» Software Quality
Assurance
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SOFTWARE QUALITY ASSURANCE
SQA-5 The SQA group audits designated software | Chapter 2.0 e Quality Assurance | ¢ Quality Assurance
work products to verify compliance. e Quality Reviews Plan Template
Chapter 3.0 * In-Stage * Quality Assurance
* Develop Quality Assurance Assessments Plan Example
Plan » Stage Exit *  Quality Assurance
Meetings Checklist
e Structure » Stage Exit Process
Walkthroughs Guide
* InStage
Assessment
Process Guide
e Structure
Walkthroughs
Process Guide
» Software Quality
Assurance
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SOFTWARE QUALITY ASSURANCE

SQA-6

The SQA group periodically reports the
results of its activities to the software
engineering group.

Chapter 2.0

e Quality Reviews

Chapter 3.0

* Develop Quality Assurance
Plan

Quality Assurance
Plan

In-Stage
Assessments
Stage Exit

e Quality Assurance
Template

e Quality Assurance
Plan Example

*  Quality Assurance
Checklist

» Stage Exit Process
Guide

* InStage
Assessment
Process Guide

» Software Quality
Assurance

SQA-7

Deviationsidentified in the software
activities and software work products are
documented and handled according to a
documented procedure.

Chapter 2.0

» Lifecycle Model

* Project Sizes

e Adapting the Lifecycle
Chapter 3.0

* Develop Quality Assurance

Plan
» Develop Project Plan

Project Plan
Quality Plan
In-Stage
Assessments
Stage Exit
Meetings

* Project Plan
Example

e Quality Assurance
Template

*  Quality Assurance
Plan Example

e Quality Assurance
Checklist

» Stage Exit Process
Guide

* |n Stage
Assessment
Process Guide

» Software Quality
Assurance
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SOFTWARE QUALITY ASSURANCE

SQA-8 The SQA group conducts periodic reviews | Chapter 2.0 ¢ Quality Plan * Quality Assurance

of its activities and findings with the * Quadlity Reviews * In-Stage Template

customer’s SQA personnel, as appropriate. | Chapter 3.0 Assessments e Quality Assurance

» Develop Quality Assurance ¢ Stage Exit Plan Example
Plan Meetings *  Quality Assurance

» Structure Checklist
Walkthroughs » Stage Exit Process
Guide

* InStage
Assessment
Process Guide

e Structure
Walkthroughs
Process Guide

» Software Quality
Assurance
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SOFTWARE CONFIGURATION MANAGEMENT
SCM-1 A SCM plan is prepared for each software | Chapter 3.0 » Configuration » Configuration
project according to a documented » Develop Configuration Management Plan Management
procedure. Management Plan Checklist
» Configuration
Management Plan
Template
» Configuration
Management
SCM-2 A documented and approved SCM planis | Chapter 3.0 » Configuration » Configuration
used as the basis for performing the SCM » Develop Configuration Management Plan Management
activities. Management Plan Checklist
» Configuration
Management Plan
Template
» Configuration
Management
SCM-3 A configuration management library system | Chapter 3.0 » Configuration » Configuration
is established as arepository for the » Develop Configuration Management Plan Management
software baselines. Management Plan Checklist

* Configuration
Management Plan
Template

* Configuration
Management
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SOFTWARE CONFIGURATION MANAGEMENT

SCM-4 The software work products to be placed Chapter 3.0 » Configuration » Configuration
under configuration management are » Develop Configuration Management Plan Management
identified. Management Plan Checklist

» Configuration
Management Plan
Template

» Configuration
Management

SCM-5 Change requests and problem reportsfor all | Chapter 3.0 » Configuration » Configuration

configuration items/units are initiated, » Develop Configuration Management Plan Management

recorded, reviewed, approved, and tracked Management Plan Checklist

according to a documented procedure. » Configuration
Management Plan
Template

» Configuration
Management

SCM-6 Changes to baselines are controlled Chapter 3.0 » Configuration » Configuration

according to a documented procedure. » Develop Configuration Management Plan Management

Management Plan Checklist

» Configuration
Management Plan
Template

» Configuration
Management
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SOFTWARE CONFIGURATION MANAGEMENT
SCM-7 Products from the software baseline library | Chapter 3.0 » Configuration » Configuration
are created and their releaseis controlled » Develop Configuration Management Plan Management
according to a documented procedure. Management Plan Checklist
» Configuration
Management Plan
Template
» Configuration
Management
SCM-8 The status of configuration items/unitsis Chapter 3.0 « Configuration » Configuration
recorded according to a documented » Develop Configuration Management Plan Management
procedure. Management Plan Checklist
» Configuration
Management Plan
Template
» Configuration
Management
SCM-9 Standard reports documenting the SCM Chapter 3.0 » Configuration » Configuration
activities and the contents of software » Develop Configuration Management Plan Management
baseline are devel oped and made available Management Plan Checklist

to affected groups and individuals.

» Configuration
Management Plan
Template

» Configuration
Management
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SOFTWARE CONFIGURATION MANAGEMENT
SCM-10 | Software baseline audits are conducted Chapter 3.0 » Configuration » Configuration

according to a documented procedure.

» Develop Configuration
Management Plan

Management Plan

Management
Checklist

» Configuration
Management Plan
Template

» Configuration
Management
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